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Gabriele Francione

Abstract

The thesis presents a preliminary study about a major hydraulic infrastructure that is
the Cavour Canal, a water distribution work that supports the irrigation of a major area
in the north of Piemonte. First, historical documentation was considered to frame the
infrastructure development and to define the channel layout, the design slopes and the
geometric characteristics of the channel cross section. This information is then com-
plemented with ground elevation information and aerial overviews. Water inflows and
outflows of the canal and the most significant hydraulic nodes associated to them —such
as branch canals and irrigation ditches— were examined in order to get a preliminary
understanding of the variations in discharge along the entire course of the Cavour Canal.
The HEC-RAS model was selected for hydraulic simulations, and a set-up has been cre-
ated with the collected information and estimation of missing parameters. Some analyses
were performed on the results including simulated flows along the channel. Quantitative
information provided by irrigation consortia were helpful to get realistic simulations from
the one-dimensional analysis of a six-year study period.
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1 Introduction

The Cavour Canal is one of Piedmont’s major hydraulic infrastructures and its impor-
tance lies in its connection to a larger irrigation water distribution system. To study its
hydraulic behavior, it is necessary to develop a model that approximates its actual behav-
ior and must take into account the structure of the irrigation distribution system, study
the canal conditions due to the operation of the floodgates, which can cause flooding and
water shortages and study the seasonal trends of actual flow rates. The proposed model
takes into account historical design data, the geometric characteristics of the canal and
available quantitative hydrometric data.

1.1 The History of the Cavour canal

The history of the Cavour canal, the subject of this thesis, begins around 1840, when
Francesco Rossi from Vercelli was the first to conceive its construction. The project was
commissioned by the Prime Minister of the Kingdom of Sardinia, Count Camillo Benso di
Cavour (after whom the canal is named) and entrusted to the engineer Carlo Noè. Noè’s
design placed the canal’s origin in Chivasso, from where it would continue through the
central Vercelli area, the Novara area, and Lomellina, with the aim of irrigating a vast
portion of the plain before finally flowing into the Ticino River. The Italian Parliament
approved the project in 1862, shortly after the proclamation of the Kingdom of Italy, and
its construction cost approximately forty-five million lire.

Figure 1: Cavour canal

Until 1977, management of the canal was entrusted to the Amministrazione generale
dei canali demaniali d’irrigazione, after which the Coutenza Canali Cavour was estab-
lished. This body, still active today, also manages other canals in the area and it is
composed by two geographical consortium, Ovest and Est Sesia. 1

The Cavour canal stretches for 83 km, and at its intake in Chivasso from the Po
River, it was designed to have a maximum flow rate of 110m3/s, which can decreases to
85m3/s near Novara.

1https://coutenzacanalicavour.it/
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1.2 Definitions

• Subsidiary canals:

A canal is subsidiary if it supplies the main canal to which it is connected with all
or part of its flow rate.

• Branch canals:

A branch canal is a branch of the main canal that transports water to more specific
areas of a hydraulic network, typically in irrigation or water distribution systems.

• Concession flow rate:

The concession flow rate is the maximum authorized flow rate that can be with-
drawn or conveyed in the canal according to the administrative concession.

• Derived flow rate:

It is the flow that is subtracted from the current of the main canal to feed the
branch canals. It depends on variables such as the water level of the Cavour canal
and the geometry of the floodgate.

• Inlet flow rate:

It is the quantity of water that is introduced into a canal thanks to the water supply
of the subsidiary canals connected to it.

• Lateral outlet floodgates:

Structures located near the bank of the main canal and in correspondence with a
branch canal. Their opening varies the derived flow rate value.

• Inlet hydraulic nodes:

Structures located at the end of the subsidiary canals and in correspondence with
the main canal which they feed with the intake of the inlet flow rate.

1.3 Geometric data of the Cavour canal

The intake structure of the canal is located on the Po River, in the city of Chivasso. From
the intake point, the canal intersects numerous watercourses along its route, which are
crossed by means of highly complex hydraulic works. The Dora Baltea is spanned by an
aqueduct bridge, at which point the subsidiary Farini canal also joins; the Ivrea canal is
crossed in elevation, while the Elvo Stream is passed beneath through a siphon culvert.

Continuing into the Vercellese area, the canal passes beneath the Cervo Stream and
reaching kilometer 55 it meets the Sesia River, also crossed by means of a large siphon
culvert. Entering the Novara area, the canal intersects the Busca and Biraga irrigation
ditches and, further downstream, the Agogna Stream. Beyond Novara, two main branch
canals diverge: the Quintino Sella and the Vigevano after which the main course ends in
the Ticino River.

The riverbed, with an initial bottom width of 40 meters (a), gradually narrows to 20
meters (b) with a slope of 0.25‰, then to 12.50 meters (c) after the intersection with the
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Busca ditch, and finally to 7.50 (d) meters after crossing the Terdoppio river. The banks,
lined with concrete, have a slope of 1:1.5 and a variable height from 2.70 to 4 meters.
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2 Topographic data of the Cavour Canal

The Cavour canal crosses the territories of twenty-three municipalities in Piedmont, and
its course had to take into account the region’s topography in order to ensure a constant
hydraulic load along the entire length of the canal.

It is useful in this regard to define the concept of the elevation of a point and, in partic-
ular, to distinguish between orthometric height, ellipsoidal height, and geoid undulation.
2

Figure 3: Elevation of a point

The geoid can be defined as the equipotential surface that passes through mean sea
level, while the reference ellipsoid is a mathematically defined surface obtained by rotating
an ellipse around one of its principal axes in order to approximate the geoid.

The orthometric height of a point P indicates its distance from the geoid measured
along the plumb line orthogonal to the geoid itself, while the ellipsoidal height of P
indicates its distance from the ellipsoid measured along the normal. It follows that
the geoid undulation is given by the difference between the orthometric height and the
ellipsoidal height.

The elevation difference can instead be defined as the difference in orthometric height
between two points; in this way, the elevation difference is positive or negative depending
on whether the height of the second point is greater or smaller than that of the first.

∆AB = zB − zA

Let us now recall the methods of measuring elevation differences that may have been
used in the years immediately preceding the construction of the canal. We distinguish be-
tween direct and indirect leveling: the former are measurements independent of distance
and include geometric, hydrostatic, and barometric leveling; on the other hand, assum-
ing the measurement of the distance between the two points, we have indirect leveling
methods such as stadia leveling and trigonometric leveling.

Since all the instruments useful for leveling were already in use by 1840, the designers
could choose whether to use a level and leveling rods (geometric leveling), simulate a sys-
tem of communicating vessels (hydrostatic leveling), take measurements with a barometer

2G. Comoglio. Topografia e cartografia. Celid, 2006.
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Figure 4: Elevation difference

(barometric leveling), or use theodolites and distance meters (stadia and trigonometric
leveling).

Once the methods of measuring the elevation difference between two points are known,
and the distance between them is also known, it is possible to obtain the hydraulic
gradient i, which is given by the ratio between the elevation difference (rise or fall) and
the horizontal distance covered, and is usually expressed as a percentage.

i = −∂h

∂s
⇐⇒

{
Ω = cost
Q = cost

=⇒ U = cost

Moreover, according to Bernoulli’s theorem 3, the piezometric head h is given by the
sum of the orthometric height z and the piezometric height p/γ; the latter term is also
called the pressure head and, in the case of uniform flow in open-canal currents, it depends
on atmospheric pressure. It follows that the only variable parameter in choosing the river
course is the geodetic height; thus, if the elevations of the Piedmontese municipalities
are known, it is possible to identify the ideal route by connecting municipalities with
progressively decreasing heights above mean sea level.

h = z +
p

γ

3D. Citrini and G. Noseda. Idraulica. CEA, 1987.
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Analyzing the current route, it is observed that the canal passes through the territories
of three Piedmontese provinces, namely the Metropolitan City of Turin, the Province of
Vercelli, and the Province of Novara.

The municipalities crossed by the canal are: Chivasso, Verolengo, Saluggia, Lamporo,
Livorno Ferraris, Bianzè, Tronzano Vercellese, Crova, San Germano Vercellese, Santhià,
Casanova Elvo, Formigliana, Balocco, Villarboit, Albano Vercellese, Greggio, Recetto,
Biandrate, Vicolungo, San Pietro Mosezzo, Novara, Cameri, and Galliate.

Table 1: Elevations of the areas crossed by the Cavour canal

Province City Orthometric Elevation Geographic Position

Height m Difference m

Torino Chivasso 175.00 - 45°11′01′′N 7°53′43′′E
Torino Verolengo 179.42 4.42 45°11′43′′N 7°57′53′′E
Vercelli Saluggia 172.70 -6.72 45°12′49′′N 8°02′07′′E
Vercelli Lamporo 173.31 0.61 45°14′26′′N 8°05′01′′E
Vercelli Livorno Ferraris 172.67 -0.64 45°16′03′′N 8°07′32′′E
Vercelli Bianzè 170.13 -2.54 45°17′23′′N 8°09′23′′E
Vercelli Crova 168.19 -1.94 45°19′55′′N 8°12′29′′E
Vercelli San Germano Vercellese 168.14 -0.05 45°21′17′′N 8°13′42′′E
Vercelli Casanova Elvo 166.57 -1.57 45°23′40′′N 8°14′40′′E
Vercelli Formigliana 165.45 -1.12 45°25′50′′N 8°17′06′′E
Vercelli Balocco 161.90 -3.55 45°26′41′′N 8°17′45′′E
Vercelli Villarboit 161.47 -0.43 45°26′34′′N 8°20′31′′E
Vercelli Albano Vercellese 164.22 2.75 45°26′55′′N 8°21′40′′E
Vercelli Greggio 164.81 0.59 45°27′19′′N 8°22′44′′E
Novara Recetto 160.29 -4.52 45°27′17′′N 8°26′11′′E
Novara Biandrate 161.59 1.30 45°27′30′′N 8°27′42′′E
Novara Vicolungo 158.92 -2.67 45°27′42′′N 8°29′11′′E
Novara San Pietro Mosezzo 160.47 1.55 45°28′00′′N 8°31′20′′E
Novara Vignale 159.96 -0.51 45°28′45′′N 8°36′32′′E
Novara Cameri 160.89 0.93 45°29′16′′N 8°39′47′′E
Novara Galliate 155.49 -5.40 45°29′12′′N 8°42′39′′E
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2.1 Design data of the Cavour canal

More accurate measurements were taken once the localities were selected. These new
values were used for the historical project, and are still available. Among these values
there are the orthometric heights taken at 500 meters from the canal axis which are
reported in the following table;

Table 2: Design Heights

First Orthometric Second Orthometric Elevation Reach

Height m Height m Difference m Lenght m

178.61 178.12 0.49 1000

178.12 176.72 1.39 2000

176.72 176.77 -0.05 7473

176.77 171.47 5.30 2300

171.47 165.72 5.75 26647

165.72 165.25 0.47 180

165.25 164.59 0.66 900

164.59 164.30 0.29 1000

164.30 165.22 -0.93 1500

165.22 164.85 0.37 1610

164.85 164.09 0.76 2910

164.09 163.38 0.71 7620

163.38 163.38 0.00 270

163.38 163.12 0.26 1090

163.12 160.71 2.41 1500

160.71 160.49 0.22 1000

160.49 158.79 1.70 3570

158.79 159.28 -0.49 8030

159.28 159.27 0.01 1400

159.27 158.20 1.07 1910

158.20 156.36 1.84 4090

156.36 153.19 3.16 4230

153.19 128.48 24.72 0

The reach lenghts reported on Tab. 2 are referred to the height measurements. From
their sum the stationing distances of canal Cavour are ordered from downstream to up-
stream. In the following table these lenghts are coupled with the respective canal-bed
width allowing for the evaluation of each canal cross section.
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Table 3: Stationing and canal bed widths

Reach Stationing Canal bed

lenght m distance m width m

1000 82230 40

2000 81230 35.56

7473 79230 26.67

2300 71757 20

26647 69457 20

180 42810 20

900 42630 20

1000 41730 20

1500 40730 20

1610 39230 20

2910 37620 20

7620 34710 20

270 27090 20

1090 26820 20

1500 25730 20

1000 24230 20

3570 23230 20

8030 19660 20

1400 11630 12.5

1910 10230 12.5

4090 8320 12.5

4230 4230 7.5

0 0 7.5



3 Free Surface Currents

Since the Cavour channel currents are free-surface currents, the equations governing these
flows are introduced below.

3.1 De Saint-Venant

Figure 5: De Saint-Venant Model

Acceleration along s:

As =
∂U

∂t
+ U

∂U

∂s
Newton’s law:

• ρ = fluid’s density

• ds = variation in space

• Ω = surface area

• U = velocity

∞∑
n=1

Fs,i = dm As = ρ Ω ds

(
∂U

∂t
+ U

∂U

∂s

)
Mass forces:

• γ = specific weight of the fluid

• Ω ds = volume

• ∂z
∂s

= sin α

P = −γ Ω ds
∂z

∂s
Surface forces comprises:
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1. hydrostatic thrust variation along two sections of the model:

Π1 − Π2 = pΩ−
(
pΩ +

∂pΩ

∂s
ds

)
=

(
−p

∂Ω

∂s
− Ω

∂p

∂s

)
ds

2. longitudinal component of the tangential tension:

• τ0 = tangential tension

• P = wet perimeter

Tx = −τ0 P ds

3. perpendicular component of the tangential tension:

Ty = p
∂Ω

∂s
ds

{
> 0 if Ω expands along ds

< 0 if Ω decreases along ds

The model equation becomes:

P +Π1 − Π2 + Tx + Ty = Fs,i

−γ Ω ds
∂z

∂s
− p

∂Ω

∂s
ds− Ω

∂p

∂s
ds− τ0 P ds+ p

∂Ω

∂s
ds =

= ρ ds Ω

(
∂U

∂t
+ U

∂U

∂s

)
Dividing all terms by (−γ Ω ds) the equation simplifies:

=⇒ ∂z

∂s
+

1

γ

∂p

∂s
+

τ0P
γ Ω

+
1

g

(
∂U

∂t
+ U

∂U

∂s

)
= 0

Two assumptions are made:

1. the fluid is incompressible =⇒ ∂ h
∂ s

2. energy grade line is parallel to free-water surface τ0 = γ Ω
P i =⇒

τ0 P
γ Ω

= i = J

Replacing:
∂ h

∂ s
=

∂z

∂s
+

1

γ

∂ p

∂ s
and J =

τ0P
γ Ω

=⇒ ∂ h

∂ s
+ J +

1

g

∂ U

∂ t
+

U

g

∂ U

∂ s
= 0

=⇒ ∂ h

∂ s
+

1

g

∂ U

∂ t
+

∂ U2

∂s 2g
= −J
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By deriving the piezometric head along space:

h = Y + zf =⇒ ∂h

∂s
=

∂Y

∂s
+

∂zf
∂s

=⇒ ∂zf
∂s

= −if

=⇒ ∂Y

∂s
+

∂zf
∂s

+
∂

∂s

U2

2g
+

1

g

∂U

∂t
= −J

=⇒ ∂Y

∂S
+

∂

∂s

U2

2g
+

1

g

∂U

∂t
= if − J

The continuity equation for an incompressible fluid (ρ = 0) becomes:

∂ ρQ

∂ s
+

∂ ρΩ

∂ t
= 0 =⇒ ∂ Q

∂ s
+

∂ Ω

∂ t
= 0

Combining the two equations results in the De Saint-Venant Model:{
∂Y
∂S

+ ∂
∂s

U2

2g
+ 1

g
∂U
∂t

= if − J
∂ Q
∂ s

+ ∂ Ω
∂ t

= 0
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3.2 Uniform flow

The Cavour canal flow can be approximated with uniform flow if the assumptions that
allows for the approximation are satisfied; in particular the uniform flow requires:

∂

∂t
=

∂

∂s
= 0 and

{
∂Y
∂S

+ ∂
∂s

U2

2g
+ 1

g
∂U
∂t

= if − J
∂ Q
∂ s

+ ∂ Ω
∂ t

= 0
=⇒ if = J

Rigorously, this would mean that there are no variations along the sections of the canal
and that there are no variations in flow rate over time. Also the slope of the piezometric
head has to be exactly equal to the slope of the canal bottom and this is insured by having
only one specific canal velocity U that satisfy this condition. When for example there is
a variation of the canal geometry, mathematically this case would belong to permanent
flow

(
∂
∂t

= 0
)
but for the project of an artificial canal this case can be neglected having

the uniform flow more stringent conditions.

Figure 6: Uniform Flow Profile Example

The Chezy equation for Uniform Flow velocity is:

U = χ
√

R if

where:

• R = Ω
P = hydraulic radius

• χ = Chezy roughness coefficient, which can be selected from:

– ks R
1
6 Gauckler-Strickler;

–
√
8g√
λ
Colebrook;

– 1
n
R 1

6 Manning;
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Knowing that:

=⇒

{
Q = U Ω

Ω = f(Y )

The flow rate formula can be derived from the Chezy uniform velocity equation:

Q = Ω χ
√
R if

And so the flow curve (Y, Q) is governed by the integral in space:

Q =

∫∫
U(x, y) dx dy
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4 Subsidiary and branch canals

To address flow shortage of the Cavour canal, due to summer droughts at the Po river
in Chivasso, several supplementary works were undertaken to stabilize and increase the
water supply. In 1868, the subsidiary Farini canal was constructed, drawing from the
Dora Baltea and capable of diverting water into the Cavour, thus compensating for the
summer low flows of the Po (Fig.7). At the same time, work began on the distribution
network: in the same year, the Montebello ditch and the Galliate consortium ditch were
opened, providing water to the Novara and Lomellina territories.(Fig.15)

The most significant addition was the construction of the Quintino Sella Branch canal,
(Fig. 11) completed in 1871. With its more than twenty-three kilometers in length, it
enabled improved irrigation distribution and also the exploitation of water drops for
energy purposes. In the years immediately following, the system was extended with
sub-branches toward Pavia and Mortara, further expanding the irrigated area.

In this way, thanks to a series of complementary works, the system gradually ap-
proached the flow originally stipulated by the 1862 convention, namely 90 cubic meters
per second beyond the Sesia. In addition to the direct diversions from the Po at Chivasso
and from the Dora Baltea through the Farini, the Cavour canal also received, over time,
contributions from the Ticino thanks to the Diramatore Alto Novarese (Fig. 9) and the
Regina Elena canals (Fig. 10). This was made possible in 1954 through the regulation of
Lake Maggiore at Miorina and the release of water into the canal via the Veveri outlet. In
this way, the Cavour’s capacity to ensure extensive and continuous irrigation of the No-
vara and Lomellina territories was definitively consolidated, overcoming the limitations
that had marked its early years. 4

4https://www.ovestsesia.it/storia/canale-cavour/
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4.1 Farini subsidiary canal

The first hydraulic work supplying the Cavour canal when proceeding downstream from
Chivasso is the Farini canal. It connects to the Cavour canal approximately 12 km
from Chivasso, near the town of Saluggia. The canal is named after Luigi Carlo Farini,
Prime Minister of the Kingdom of Italy. The Farini canal was constructed in 1868 in
order to increase the discharge of the Cavour canal, which initially suffered from water
shortages during the summer months due to the presence of a single intake from the
Po River. Through the Farini canal, the cold water from the Dora Baltea River can be
diverted, ensuring adequate flow conditions in the Cavour canal under all hydrological
scenarios. The main characteristics of the Farini canal are its relatively short length,
approximately 3 km, and its considerable width of about 35 m, which locally reaches
dimensions comparable to the riverbed of the Dora Baltea. The initial value of discharge
used for the simulations is set at 10 m3/s and is consistent with the quantitative data of
the Ovest Sesia consortium. 5 6

Figure 7: Farini - 1:1000

5https://www.parcopopiemontese.it/pun-dettaglio.php?id=970
6https://www.ovestsesia.it/
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4.2 Ivrea subsidiary canal

Similarly to the Farini canal, the Ivrea canal also originates from the Dora Baltea River,
but much further upstream, specifically within the historic center of Ivrea. It terminates
in Vercelli, where it discharges into the Sesia River. The canal was originally constructed
in 1468 by the House of Savoy as a navigable link between Ivrea and Vercelli. Today, it
primarily supplies irrigation water to the rice fields of the Vercelli plain. From Masino,
the canal follows the Masino moraine and subsequently runs alongside the Dora Baltea
for several kilometers, intersecting first the Depretis canal and then reaching the town
of Santhià. The Ivrea canal continues until it meets the Cavour canal, where, at ap-
proximately 34 km from Chivasso, it contributes part of its discharge through the Naia
Hydraulic Node. For the evaluation of its discharge, a conservative value of 10 m3/s is
taken into account to comply with the concession flow rate. 7

Figure 8: Ivrea Canal - 1:1000

7https://it.wikipedia.org/wiki/Naviglio-di-Ivrea
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4.3 Alto Novarese subsidiary canal

The Alto Novarese subsidiary canal originates from the Regina Elena canal and has an
average discharge of approximately 25 m3/s. It is about 21 km long and has an average
width of roughly 10 m. Following a series of enlargement works carried out by the Est
Sesia Irrigation Consortium, the canal became operational in 1981. Along its course, it
crosses the Terdoppio and Agogna streams by means of siphon culverts, while it overpasses
the Mora–Strona ditch via an aqueduct bridge. The canal terminates by discharging into
the Cavour canal at Recetto, approximately 68 km from Chivasso. In recent years, an
additional hydraulic structure has been constructed to allow part of the Alto Novarese
discharge to supply the Montebello canal. 8

Figure 9: Alto Novarese subsidiary canal - 1:1000

8https://it.wikipedia.org/wiki/Diramatore-Alto-Novarese
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4.4 Regina Elena subsidiary canal

The Regina Elena canal flows entirely within the Province of Novara. Its construction
began in 1938 and was completed in 1954. The canal is 25 km long and has a discharge
of approximately 70 m3/s at its intake from the Ticino River, which decreases to about
45 m3/s downstream of the diversion to the Alto Novarese subsidiary canal. The Regina
Elena canal discharges into the Cavour canal in order to supply its downstream reach and
mitigate water shortages during drought periods. The confluence occurs approximately
74 km from Chivasso, just upstream of the Quintino Sella and Vigevano branch canals. 9

Figure 10: Regina Elena - 1:500

9https://it.wikipedia.org/wiki/Canale-Regina-Elena
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4.5 Quintino Sella branch canal

The Quintino Sella branch canal was constructed between 1870 and 1874, following the
completion of the Cavour canal. It supplies irrigation water to the provinces of Novara
and Pavia and derives its discharge directly from the Cavour canal. The canal has a
width of approximately 10 m, a depth exceeding 3 m, and a maximum discharge of up to
38 m3/s. It branches off from the Cavour canal about 74 km downstream of Chivasso,
near Veveri, north of Novara, immediately after the inflow from the Regina Elena canal.
Downstream, the Quintino Sella canal divides into two sub-branches: the Pavia sub-
branch, flowing toward the city of Pavia, and the Mortara sub-branch, directed toward
Mortara. The canal is used for irrigation purposes as well as for hydroelectric power
generation and hosts several fish species. 10

Figure 11: Inlet of the Quintino Sella canal - 1:500

10https://it.wikipedia.org/wiki/Canale-Quintino-Sella
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4.6 Vigevano branch canal

The Vigevano branch canal was constructed in 1868 and was originally known as the
Belletti Ditch. It has an average discharge of approximately 22 m3/s and a total length
of 29 km. The canal branches off from the Cavour canal about 81 km downstream of
Chivasso, near the municipality of Galliate in the Province of Novara. Along its course, it
supplies the Cerana ditch and overpasses the Moretta ditch before eventually discharging
into the Pavia sub-branch canal. 11

Figure 12: Vigevano Branch canal - 1:1000

11https://it.wikipedia.org/wiki/Diramatore-Vigevano
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4.7 Busca branch canal

The Busca ditch was originally constructed by the city of Novara in the 14th century
and was initially known as the Novarese ditch. In the 17th century, ownership passed to
Count Ludovico Busca, from whom the ditch takes its present name. The ditch crosses the
provinces of Novara and Pavia and originates from the Sesia River near the municipality
of Ghemme. It has a total length of 54 km and an average width of approximately 9 m.
The Busca ditch crosses the Cavour canal at around 62 km from Chivasso by means of
a siphon culvert, but it also receives a water subsidy from the Cavour canal, reaching a
downstream discharge of approximately 34 m3/s. Further downstream, it intersects the
Biraga ditch and continues southward into the Lomellina area. 12

Figure 13: Busca Ditch - 1:1000

12https://it.wikipedia.org/wiki/Roggia-Busca
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4.8 Biraga branch canal

The Biraga Ditch, like the Busca, is of ancient origin and was constructed in the 15th
century by the city of Vercelli. Part of its route runs parallel to that of the Busca Ditch. It
originates from the Sesia River and subsequently crosses first the Alto Novarese subsidiary
canal and then the Cavour canal at approximately 60 km from Chivasso. Downstream of
the Cavour canal, it receives a discharge subsidy, reaching a flow rate of about 27 m3/s
and an average width of approximately 10 m. The ditch then intersects the Busca Ditch
and continues until it splits into two outlets, one discharging into the Sesia River and the
other into the Agogna Stream. It supplies three hydroelectric power plants and is used
for irrigation by the Est Sesia Consortium. 13

Figure 14: Biraga Ditch - 1:500

13https://it.wikipedia.org/wiki/Roggia-Biraga
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4.9 Montebello branch canal

The Montebello canal is an irrigation canal constructed in 1868 and named after a battle
of the Second Italian War of Independence. It flows within the Province of Novara
and branches off from the Cavour canal at approximately 68 km from Chivasso, near
the municipality of Recetto. Since 1980, following the completion of the Alto Novarese
subsidiary canal, the Montebello canal has also been supplied by the latter, reaching a
discharge of approximately 10 m3/s. 14

Figure 15: Montebello canal - 1:500

14https://it.wikipedia.org/wiki/Cavo-Montebello
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4.10 Lucca branch canal

The Lucca canal is an artificial canal branching off from the Cavour canal at approxi-
mately 22 km from Chivasso and is managed by the Ovest Sesia Irrigation Consortium.
It was constructed in 1922 in the municipality of Livorno Ferraris. The canal is approxi-
mately 3 km long and has a discharge ranging between 6 and 8 m3/s. It terminates in the
Saluggia Naviletto, where it supplies the Lucca Hydroelectric Power Plant, operational
since 2004 with an installed capacity of 506 kW. 15

Figure 16: Lucca canal - 1:1000

15https://www.ovestsesia.it/centrali/lucca/
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5 Analysis of hydrometric measurements

5.1 Lucca canal hydrographs

The hydrograph of the Lucca canal represents the temporal evolution of discharge from
2019 to 2024. This hydrograph has been obtained using interpolation in order to recon-
struct missing data and fill temporal gaps.

Figure 17: Lucca Hydrograph with missing values
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Figure 18: Lucca Hydrograph



5.1.1 Mean Annual Discharge

The mean annual discharge of the Lucca canal has been calculated starting from the
average values of each year, and then the mean of all years is calculated.

Qmean,year =
1

n

n∑
i=1

Qi

QMAD =
1

N

N∑
j=1

Qmean,year

Table 4: Mean Annual Discharge Lucca

Year Mean

2019 6.78

2020 5.33

2021 6.67

2022 4.42

2023 3.80

2024 5.37

TOTAL 5.39
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5.1.2 Regime Curve

The regime curve of the Lucca canal shows the average seasonal variation of stream flow.
It is obtained by plotting all monthly discharge values together and then computing the
mean discharge for each month.

Figure 19: Lucca Regime Curve

5.1.3 Flow Duration Curve

The long term Flow Duration Curve of the Lucca canal combines the discharge values
from January 2019 to September 2024 and their exceedance probabilities.

Discharge values were listed in descending order without regard to the sequence of
occurrence.

To every value a rank m was assigned in order to calculate the exceedance probability
through the Weibull equation P = m

n+1
;

n = Number of discharge values;
m = Average rank. For equal values of discharge:
m =

ri+rf
2

; ri = Rank of the first value; rf = Rank of the last value;
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Figure 20: Lucca Flow Duration Curve



5.2 Farini canal hydrographs

The hydrograph of the Farini canal covers the period from 2019 to 2024 and illustrates
the changes in discharge over time. Fig. 21. This values have also been interpolated to
fill temporal gaps. Fig. 22 The data was given in MOD equivalent to 100 l/s and later
converted in m3/s for comparison with the Cavour’s hydrograph.

Figure 21: Farini hydrograph with missing values

Figure 22: Farini hydrograph
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5.2.1 Mean Annual Discharge

The mean annual discharge of the Farini canal has been calculated starting from the
average values of each year, and then the mean of all years is calculated.

Qmean,year =
1

n

n∑
i=1

Qi

QMAD =
1

N

N∑
j=1

Qmean,year

Table 5: Mean Annual Discharge Farini

Year Mean

2019 6.25

2020 5.53

2021 4.54

2022 3.80

2023 4.53

2024 5.04

TOTAL 4.95

The values calculated in Tab. 5 show that the time period 2022-2023 has the lowest
discharge values for the Farini canal; the mean discharge value for the time period 2022-
2023 is:

Qmean =
Q2022

m +Q2023
m

nyears

=
3.80 + 4.53

2
m3/s = 4.17m3/s
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5.2.2 Regime Curve

The regime curve of the Farini canal shows the average seasonal variation of stream flow.
It is obtained by plotting all monthly discharge values together and then computing the
mean discharge for each month.

Figure 23: Farini Regime Curve
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5.2.3 Flow Duration Curve

The long term Flow Duration Curve of the Farini canal combines the discharge values
from January 2019 to September 2024 and their exceedance probabilities.

Discharge values were listed in descending order without regard to the sequence of
occurrence.

To every value a rank m was assigned in order to calculate the exceedance probability
through the Weibull equation P = m

n+1
;

n = Number of discharge values;
m = Average rank. For equal values of discharge:
m =

ri+rf
2

; ri = Rank of the first value; rf = Rank of the last value;

Figure 24: Farini Flow Duration Curve
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5.3 Cavour canal hydrographs

Similarly, the Cavour canal’s hydrograph shows discharge variations from 2019 to 2024.
Fig. 25 The hydrograph was derived from regional temporal data registered in the Cavour
canal after the Farini subsidy and was later interpolated like the previous cases. Fig. 26.
16

Figure 25: Cavour hydrograph with missing values

The results obtained thanks to the hydrometric measurements allow for the temporal
analysis of flow rate values. The frequency of precipitation and the contribution of the
inflow and outflow canals influence the results. Fig 26

Figure 26: Cavour hydrograph

16https://www.arpa.piemonte.it/dati
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5.3.1 Mean Annual Discharge

The mean annual discharge of the Cavour Canal has been calculated starting from the
average values of each year, and then the mean of all years is calculated.

Qmean,year =
1

n

n∑
i=1

Qi

QMAD =
1

N

N∑
j=1

Qmean,year

Table 6: Mean Annual Discharge Cavour

Year Mean

2019 55.79

2020 48.62

2021 37.95

2022 36.65

2023 46.53

2024 50.01

TOTAL 45.93

The values calculated in Tab. 5 show that the time period 2021-2022 has the lowest
discharge values for the Cavour canal; the mean discharge value for the time period
2021-2022 is:

Qmean =
Q2021

m +Q2022
m

nyears

=
37.95 + 36.65

2
m3/s = 37.30m3/s
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5.3.2 Regime Curve

The regime curve of the Cavour canal shows the average seasonal variation of stream flow.
It is obtained by plotting all monthly discharge values together and then computing the
mean discharge for each month.

Figure 27: Cavour Regime Curve
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5.3.3 Flow Duration Curve

The long term Flow Duration Curve of the Cavour canal combines the discharge values
from January 2019 to September 2024 and their exceedance probabilities.

Discharge values were listed in descending order without regard to the sequence of
occurrence.

To every value a rank m was assigned in order to calculate the exceedance probability
through the Weibull equation P = m

n+1
;

n = Number of discharge values;
m = Average rank. For equal values of discharge:
m =

ri+rf
2

; ri = Rank of the first value; rf = Rank of the last value;

Figure 28: Cavour Flow Duration Curve
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5.4 Farini and Cavour Hydrograph Comparison

It is now possible to view more in details the comparison of flow rates from the two
canals. The period from 2021 to 2022 is characterized by flow shortages from the Cavour
canal with an average flow rate of 37.30m3/s while the Farini canal has flow shortages
during the years 2022 and 2023 with an average flow rate of 4.17m3/s. The following
hydrographs highlight drought periods of the two canals. The blue line is the result of
the difference of the two canals discharge and shows the amount of water provided by the
Po river at the Cavour’s incile in Chivasso.

Figure 29: Farini and Cavour hydrograph comparison 2021-2022

Figure 30: Farini and Cavour hydrograph comparison 2022-2023
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6 The lateral outlet floodgates of the Lucca canal

6.1 Lucca canal water surface

Assuming that the Lucca canal has a rectangular floodgate, and knowing from Table 15
that its width is bf = 5m and from the hydrograph of Fig. 18 that its flow rate varies
throughout the year but has a maximum value of 9 m3/s, using a Manning’s coefficient
of n = 0.04m1/3/s for a clean canal bed with some pools and shoals and assuming also
if = 0.0025, the height of the water surface level Y can be determined using the Chezy
formula.

Q = bfY
1

n
R1/6

√
R if

Q = bfY
1

n

[
(bfY )

(bf + 2Y )

]1/6√[
(bfY )

(bf + 2Y )

]
if

The results calculated are reported in the Table 7 below;

Table 7: Lucca canal water surface height

Flow rate Manning’s n Width m if Water surface

m3/s value height m

9 0.04 5 0.0025 1.50

8 0.04 5 0.0025 1.38

7 0.04 5 0.0025 1.26

6 0.04 5 0.0025 1.13

5 0.04 5 0.0025 1.00

4 0.04 5 0.0025 0.86

3 0.04 5 0.0025 0.71

2 0.04 5 0.0025 0.55

1 0.04 5 0.0025 0.35

By introducing on HEC-RAS a model of the canal and imposing the same boundary
conditions of the problem, the software calculate similar results to that obtained using
Chezy’s uniform flow equation reported in Tab. 7.
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Figure 31: W.S. Heights From HEC-RAS

Table 8: Lucca canal water surface height from HEC-RAS

Flow rate Water surface Canal-bed Water surface

m3/s elevation m elevation m height m

9 168.66 167.38 1.28

8 168.57 167.38 1.19

7 168.48 167.38 1.1

6 168.38 167.38 1

5 168.28 167.38 0.9

4 168.16 167.38 0.78

3 168.04 167.38 0.66

2 167.89 167.38 0.51

1 167.71 167.38 0.33

The levels of the water surface reported on Tables 7 and 8 recur with the annual
frequencies that results from the flow duration curve of the Lucca canal in Fig. 20 and
are reported in the following table.

The same calculation has been repeated for the value of the Mean Annual Discharge
for the Lucca canal. From Tab. 4 the observed discharge value is 5.39m3/s and using
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Table 9: Lucca Flow Duration Curve results

Flow rate Exceedance Exceedance

Q m3/s probability % frequency days
year

9 3.93 14

8 25.34 92

7 45.46 166

6 55.84 204

5 62.50 228

4 67.35 246

3 72.68 265

2 77.22 282

1 81.49 297

the Chezy formula, the corresponding uniform flow level is 1.05 m.
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6.2 Lucca floodgate heights

The floodgate opening height adjustment of the Lucca canal allows to determine the flow
rate values mentioned above; in the case of an opening height of 0.15 m the Bernoulli’s
theorem is applied to obtain a flow rate Q of this specific case.

Figure 32: Floodgate Opening

HA = HB

=⇒ zA +
pA
γ

+
U2
A

2g
= zB +

pB
γ

+
U2
B

2g

Two points A and B can now be chosen from the Cavour canal and the Lucca canal
in order to simplify the calculations. This can be achieved by placing A on the water
free-surface of the Cavour canal and B right after the contracted section created by the
floodgate.

zA +
pA
γ

= ZCWS;

U2
A

2g
= 0

zB +
pB
γ

= CC ZFOH

Where ZCWS is the water free-surface of the Cavour canal, ZFOH is the opening of the
floodgate and CC the coefficient of contraction, which is assumed to be equal to 0.61.
This way the Bernoulli’s equation is simplified:

ZCWS = CC ZFOH +
U2
B

2g
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From which it is obtained the flow rate exiting the floodgate:

Q = UB Ω = UB [CC ZFOH W ]

Where W is the value of width taken from Tab. 7, equal to 5 m.

UB =
√
(ZCWS − CC ZFOH)2g

Q =
√

(ZCWS − CC ZFOH)2g [CC ZFOH W ]

Table 10: Upstream section of the Lucca canal outlet

Parameter Value Unit of

measurement

Canal Cavour -

Cross section 60434 m

Flow rate 45.93 m3/s

Water surface elevation 169.85 m

Canal bed elevation 168.50 m

By knowing from the HEC-RAS model that at the upstream section of the Lucca
canal outlet, the Cavour canal has a water surface height of 169.85 m, it is obtained:

ZCWS = 169.85− 168.5 = 1.35m

Q =
√

2 · 9.8m/s2 · [1.35m− (0.61 · 0.15m)] · [0.61 · 0.15m · 5m] = 2.27m3/s
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The previous calculation can be repeated for progressively increasing heights. The
following simulation will have 5 cm increments in the floodgate opening and the results
obtained are reported in Tab. 11 below.

Table 11: Floodgate height variation

Floodgate Flow rate

opening height m m3/s

0.15 2.272

0.20 2.993

0.25 3.694

0.30 4.376

0.35 5.038

0.40 5.680

0.45 6.302

0.50 6.902

0.55 7.480

It is possible to obtain the values of height opening related to Bernoulli’s equation for
flow rates:

Q =
√
(ZCWS − CC ZFOH)2g [CC ZFOH W ]

Table 12: New floodgate heights

Flow rate New floodgate

m3/s opening height m

9.00 0.691

8.00 0.597

7.00 0.508

6.00 0.426

5.00 0.347

4.00 0.272

3.00 0.201

2.00 0.131

1.00 0.065

In order to verify the results of Tab. 12, the same calculation has been repeated with
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the Bernoulli’s equation for flow rates:

Q =
√
(ZCWS − CC ZFOH)2g [CC ZFOH W ]

The new results are very similar to the old ones, proving the theoretical procedure.

Table 13: Floodgate heights verification

Floodgate Flow rate

opening height m m3/s

0.691 8.99

0.597 8.00

0.508 7.00

0.426 6.01

0.347 5.00

0.272 4.00

0.201 3.01

0.131 1.99

0.065 1.00

At last these flow rates can be manually checked by varying the value of height opening
on the HEC-RAS model iteratively. The boundary conditions are imposed equal to the
ones used for the theoretical calculations, in particular, all other floodgates are closed
and the Cavour canal is supplied by a flow rate of 45.93 m3/s from the Po river.
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Table 14: Floodgate heights from HEC-RAS

Floodgate Upstream flow Downstream flow Resulting flow

opening height m rate m3/s rate m3/s rate m3/s

0.065 45.93 43.38 2.55

0.131 45.93 40.95 4.98

0.201 45.93 38.56 7.37

0.272 45.93 36.31 9.62

0.347 45.93 34.12 11.81

0.426 45.93 31.91 14.02

0.508 45.93 29.99 15.94

0.597 45.93 28.25 17.68

0.691 45.93 28.7 17.23



7 HEC-RAS Model

The HEC-RAS software allows to estimate the water discharge present at any point along
the canal by performing steady-flow analyses.17

This is made possible through a 1D study, which involves uploading into the software
a geometric model of the canal that includes the various slopes and lengths obtained
from historical project plans, and introducing the corresponding cross-section for each
station, derived from parameters such as bottom width, bank slope, inner embankment
inclination, and crest elevation.

For data acquisition, the work carried out by the irrigation consortia proved useful, as
they mapped the geographical positions of the outlet structures of the derivation canals
onto a QGIS model corresponding to the two areas of the Cavour canal Authority, West
and East Sesia.18

Figure 33: Cavour Canal route - 1:150000

The project originated from the analysis of the historical profiles of the canal. From
these documents, the reference elevations, the elevation of the canal bed, and the char-
acteristic slopes of the various reaches were obtained. Based on this preliminary infor-
mation, it was possible to define the general geometric configuration of the hydraulic
structure.

Subsequently, starting from these fundamental data, the canal cross-sections were
developed in Excel. For each section, the bank slopes, the bottom widths indicated in
the historical designs, and the progressive distances between the stations (moving from
downstream to upstream) were used. The result was a set of geometrically consistent
sections ready for integration into the model.

17https://www.hec.usace.army.mil/confluence/rasdocs/rasum/latest/performing-a-steady-flow-
analysis

18https://www.estsesia.it/

53



Once imported into HEC-RAS, the sections were interpolated to build a one-dimensional
model with regular intervals of about 240 meters, according to Samuel’s equation. 19[7]

spacingmax =
0.15Hbf

slope

For each section, the station and elevation values of the canal crest were also defined,
allowing the assignment of two Manning roughness coefficients: 0.03 for the canal bed
and 0.067 for the vegetated banks. These values are taken from tables and in particular
the canal bed is clean, straight, full with no rifts or deep pools and the vegetated banks
usually are very weedy. 20 The Manning’s n values are used by the software to model the
energy losses due to friction and are necessary for the computation of the water surface
elevation.

With the geometric characterization completed, multiple flow rate values taken ac-
cording to the measured values of hydrograph Fig. 26, were implemented to perform a
steady-flow analysis. The software then generated the longitudinal water surface profiles,
providing the energy grade line for each flow scenario.

The hydraulic model was enhanced with several lateral outlet floodgates along the
right bank of the Cavour canal. These include minor irrigation ditches as well as major
branch canals. For the purposes of the hydraulic simulation, two key geometric parame-
ters were reconstructed, namely the width and height of the floodgates.

The geographical position of the lateral outlets is also required to build the model;
this can be estimated through the analysis of the QGIS project that contains data related
to the structures and hydraulic works built for the Cavour canal. This also includes their
names and locations.

QGIS therefore allows for the measurement of the distance between two points, making
it possible to assign a stationing value to the various ditches. Those considered are among
the most important and are listed in Table 15.

19https://www.hec.usace.army.mil/confluence/rasdocs/ras1dtechref/6.4/performing-a-dam-break-
study-with-hec-ras/downstream-flood-routing-modeling-issues/cross-section-spacing-and-hydraulic-
properties

20https://www.hec.usace.army.mil/confluence/rasdocs/ras1dtechref/6.6/basic-data-
requirements/geometric-data/energy-loss-coefficients
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Some of the implemented junctions are located on the left hydraulic bank and are
defined by the intersections between the Cavour canal and the main branch canals that
supply it with part of their discharge. These include the Farini canal, the Ivrea canal,
the Alto Novarese subsidiary canal, and the Regina Elena canal.

Figure 34: Canal network - 1:200000
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7.1 Procedure to set up the HEC-RAS model

The first step when using HEC-RAS is that of creating the geometric model. By selecting
File → Import Geometry Data → CSV Format → Station–Elevation Format, the geo-
metric data were imported into the model. The creation of the Comma-Separated Values
(CSV) file required particular care and proved to be the most time-consuming step, as
HEC-RAS reads data according to the following order: River Name, Reach Name, XS,
Station, Elevation.

Figure 35: CSV import

Consequently, for each cross section reported in the historical design, from upstream
to downstream, it was first necessary to recalculate the distances of each section start-
ing from the downstream end and proceeding upstream to the intake structure. Using
the canal slopes and widths, the cross sections were then reconstructed. Subsequently,
the reach lengths table was defined, specifying for each section the distance from the
immediately upstream one.

Figure 36: Reach lenghts

The bank positions were then assigned for all cross sections. The following step
consisted in densifying the sections by applying Samuel’s formula in order to determine
the maximum allowable spacing between cross sections. [7]

Roughness values for the canal bed and banks, derived from regulatory guidelines 21,
were assigned through Tables → Edit Manning’s n → Set Values.

21https://www.hec.usace.army.mil/confluence/rasdocs/ras1dtechref/6.6/basic-data-
requirements/geometric-data/energy-loss-coefficients
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Figure 37: XS interpolation and Manning’s coefficients

For the steady-flow analysis, the discharge values for the various profiles, expressed
in cubic meters per second, were entered via Edit → Steady Flow Data in the main
window, together with the selection of the reach boundary conditions. With regard to
the inclusion of lateral outflow structures, the procedure followed was Edit → Geometric
Data → Lateral Structure → Options → Add Lateral Structure, subsequently specifying
the structure name, the corresponding station, and the geometric parameters of the weir
and gates.

Figure 38: Steady flow data and lateral structures editor

A crucial step consisted in defining the gate openings within the Steady Flow Data
window and optimizing them prior to running the steady-flow simulation Fig. 39. Pro-
vided that no errors were detected, HEC-RAS computed the hydraulic profiles, including
the Energy Grade Line and the Water Surface Line, and supplied the full set of numerical
results in tabular form Fig. 40, such as total discharge (Q total), minimum canal eleva-
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tion, water surface elevation, energy grade elevation, energy grade slope, canal velocity,
flow area, top width, and Froude number. Based on these outputs, the following plots
were generated: canal velocity Fig. 42, flow area Fig. 43, and canal top width Fig. 44.

Figure 39: Outlets optimization and gate openings

The velocity graph illustrates how the water speed within the canal varies along
its length. Changes in velocity reflect the influence of hydraulic conditions and canal
geometry, with higher velocities typically occurring in narrower or deeper sections where
the flow is more constrained. Fig. 42

Figure 40: 1D results
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Figure 41: Canal profile example with a flow rate of 100 m3/s

Figure 42: Canal velocity example with a flow rate of 100 m3/s

The cross-sectional area graph shows how the flow section area of the canal changes
spatially. This representation helps to understand how variations in canal shape affect
the flow capacity and the distribution of water within the canal. Fig. 43
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Figure 43: Canal flow area example with a flow rate of 100 m3/s

The top-width graph describes the variation of the water surface width at the upper
edge of the canal. Changes in top width are associated with differences in flow depth and
side slopes, providing insight into how the canal geometry interacts with the flow regime.
Fig. 44

Figure 44: Canal top width example with a flow rate of 100 m3/s
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7.2 Lateral floodgate structures

For the lateral floodgate structures reported on Table 15 the following assumption are
made:

Floodgates geometric parameters:

• Width: measured from aerial photos of the floodgates structures, marked on QGIS
by the consortia and reconstructed on HEC-RAS by leaving one meter of weir
embankment on each side of the lateral structure;

• Height: imposed equal to the height of the canal flank; the sill is set at the canal bed
elevation and the floodgate develops vertically until the campaign plain elevation.

Table 15: Branch canals and subsidiaries floodgates geometric parameters

Name Station m Width m Height m Type

Farini canal 70318 35 6.4 Inlet

Lucca canal 60435 5 6.3 Outlet

Ivrea canal 48546 8.5 6.4 Inlet

Alto Novarese canal 24693 10 6.1 Inlet

Montebello canal 24693 7 6.1 Outlet

Biraga canal 21635 10 6.2 Outlet

Busca canal 19635 9 6.2 Outlet

Regina Elena canal 8453 12 6 Inlet

Quintino Sella canal 8375 8 6 Outlet

Vigevano canal 1305 14 6 Outlet

7.3 Closed floodgates case

In this case all the outlet floodgates are closed. This case verifies in the so called ’dry pe-
riods’, when the branch canals are closed for maintenance works for example.22 The flow
of water of the Cavour canal is preserved from upstream to downstream not considering
dissipation. These can be caused by water losses due to the poor grip of the floodgates.
In the absence of precise information this assumption is neglected. With the assumption
of a concession flow rate of 110 m3/s and inflow flow rates of the subsidiary canals equal
to the ones reported in Table 16 an increase in the water surface elevation is seen from
the results of the model, leading to floodings.

22https://www.ovestsesia.it/2025/08/29/manifesto-disattivazione-degli-imbocchi-di-canali-
dirrigazione/
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Table 16: Flow rates from subsidiary canals

Name Station m Flow Type

Canal-Ditch Rate m3/s

Cavour canal 82230 20 Inlet

Farini canal 70318 10 Inlet

Ivrea canal 48546 10 Inlet

Alto Novarese canal 24693 25 Inlet

Regina Elena canal 8453 45 Inlet

The flow rate must be calculated from downstream to upstream since downstream
there are smaller canal cross sections, designed to hold less amount of water compared to
the upstream one due to the distribution of water to the branch canals. For this reason if
the outlet floodgates are closed and the flooding phenomenon must be avoided the flow
rate needs to be verified using the Chezy equation, applied with the canal cross section
geometry.

Q = Ω
1

n
R1/6

√
R if

Where:

α = arctan
2

3

Ω = Y bf + Y 2 tan α

P = 2
Y tan α

sin α
+ b

R =
Ω

P
=

Y bf + Y 2 tan α

2Y tan α
sin α

+ b

Q = [Y b+ Y 2tan α]
1

n

[
Y b+ Y 2tan α

2Y tan α
sin α

+ b

] 1
6

√√√√[
Y b+ Y 2tan α

2Y tan α
sin α

+ b

]
if

Figure 45: Cross section example
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Table 17: Downstream flow rates

Parameter Value Unit of measurement

Maximum main canal depth Y 4 m

canal bed width bf 7.5 m

Bank inclination α 33.69 degrees

Manning roughness coefficient n 0.03 m1/3/s

canal bed slope if 0.00025 m/m

Assuming:
The resulting flow rate is 38.16 m3/s which is less than the concession flow rate. The

opening of branch canals is required to avoid floodings.

Figure 46: Closed floodgates case
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7.4 Open floodgates case

7.4.1 Closed subsidiary canals case

In the open floodgate case scenario all the canal’s outflow floodgates are opened with
maximum opening height, which is equal to that reported on Table 15. This case study
involves the closure of all subsidiary canals and this time, the case study analyzes a
maximum flow rate taken from the Po River that reaches the concession value of 110
m3/s. In this case, it can be observed how the distribution of water favors the upstream
branch canals, which belong to the Ovest Sesia consortium, and the water level of the
Cavour canal drops along its route, resulting in a lack of water in the final stretch.

Table 18: Derivation flow rates with closed subsidiary canals

Name Station m Flow Type

Canal-Ditch Rate m3/s

Lucca canal 60435 69.87 Outlet

Montebello canal 24693 18.80 Outlet

Biraga canal 21635 12.83 Outlet

Busca canal 19635 5.76 Outlet

Quintino Sella canal 8375 2.63 Outlet

Vigevano canal 1305 0 Outlet
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Figure 47: Open floodgates case

7.4.2 Realistic opening scenario

This scenario simulates the opening of both the outflow outlets for the distribution of
water to the branch canals, and the activation of the main hydraulic nodes, for the supply
of water to the Cavour canal.

Lets start by simulating inflow rates equal to those reported in Tab. 16 to reach the
concession flow rate of 110 m3/s.

As a further assumption, also in this case all the outlets are open with maximum
opening height, reported in Table 17. The derivation flow rate in this case is also given
by the equation:

Qderivation = Qupstream −Qdownstream

By opening the outlet floodgates and the inlet hydraulic nodes, the two extreme cases
of flooding and lack of water in the downstream sections of the Cavour canal are avoided.
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Table 19: Realistic derivation flow rates

Name Station m Flow Type

Canal-Ditch Rate m3/s

Lucca canal 60435 19.29 Outlet

Montebello canal 24693 20.68 Outlet

Biraga canal 21635 14.95 Outlet

Busca canal 19635 8.02 Outlet

Quintino Sella canal 8375 8.09 Outlet

Vigevano canal 1305 32.58 Outlet

Figure 48: Realistic opening scenario



8 Summary

From the hydrograph of the Cavour Canal Fig.26, it can be observed that the discharge
of the Cavour Canal varies seasonally, ranging from a minimum of about 2.8 m3/s to a
maximum of about 100 m3/s.

The two-year period with the lowest discharges was 2021–2022, with an average flow
of approximately 37 m3/s. Considering all the available data, the overall annual average
discharge is about 46 m3/s. Tab. 6

From the regime curves, it emerges that the highest discharges occur during the
summer months. In particular, May consistently shows values above 65 m3/s, while
winter months are characterized by lower flows, generally below 30 m3/s. Figures 19, 23
and 27.

The Farini canal contribution averages 4.95 m3/s, with seasonal maximum values in
June and minimum values in February, ranging from 0 to about 11 m3/s. Tab. 5

After subtracting the water coming from the Dora Baltea river of the Farini canal,
from the Cavour Canal discharge, it appears that the Po River provided a discharge
greater than 80 m3/s only once, during the 2022 drought period. Figures 29 and 30

The Lucca Canal shows discharges ranging from 1 to 9 m3/s, with an annual average
of about 5.4 m3/s Tab.4

Since the Lucca canal is supplied by the Cavour canal, its discharge was calculated
from the Cavour canal water levels using the Bernoulli theorem. Considering the Cavour
canal with an average discharge of 45.93 m3/s, two types of results were obtained depend-
ing on the floodgate opening. For example, with a 0.40 m gate opening, the calculated
discharge is 5.68 m3/s, which approximates the annual average and from the frequency
curve it can be seen that this flow rate value is exceeded for 230 days every year Fig. 20

The HEC-RAS simulations allowed for the comparison of real data and the analysis of
various case studies, such as the opening and closing of the floodgates discussed previously.
Specifically, the Table 19 shows the results of the simulations of the flow rates of the
realistic case, which approximate those hypothesized in Chapter 4.
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